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This manual is designed for operators of the MagicHD media player to help
them quickly and effectively learn how to use the software. The reader is
assumed to have a basic familiarity with the concepts of media players and
lighting control systems. Since MagicHD is designed to be controlled by the
MagicQ range of lighting consoles, the reader should also be familiar with
MagicQ. Readers who are tight for time and just want to find out how to
quickly program a working show should turn straight to Getting Started.

ChamSys Ltd

The features and functions of the MagicHD media player and the ideas contained therein are
the property of ChamSys Ltd. The media player is intended for the control and display of
moving and static images. No warranties are expressed or implied regarding the use of the
MagicHD media player. No liabilities are accepted for the accuracy of the information
contained within this manual. The MagicHD media player product is supplied and designed
by ChamSys Ltd. Products containing ChamSys Ltd software and firmware embody
proprietary information and are licensed not sold and may not be duplicated in any way.
ChamSys Ltd does not guarantee the accuracy, adequacy, suitability or completeness of any
information or products and is not responsible for any errors or omissions or the results
obtained from use of such information or products. ChamSys Ltd does not accept
responsibility for the consequences of misuse or abuse of its software. None of the equipment
or software supplied by ChamSys Ltd may be used in any life-critical or potentially life-
endangering situations or in situations where personal injury may result. ChamSys Ltd
reserves the right to make any changes and/or improvements or to discontinue any and all of
their products or services without prior notice, and advises customers to obtain the latest
version of relevant information to verify, before placing orders, that information being relied
on is current and complete. All products are sold subject to the terms and conditions of sale
supplied at the time of order acknowledgement, including those pertaining to warranty,
patent infringement, and limitation of liability. Some of the available functions of products
may be altered over the life of the product. All other product names are trademarks or
registered trademarks of their respective owners. No part of this publication may be
reproduced or distributed, transmitted, transcribed, stored in a retrieval system, or translated
into any language in any form by any means without the prior written permission of
ChamSys Ltd.

Copyright 2026 by ChamSys Ltd. All rights reserved.
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Chapter 1. Getting Started
MagicHD is a DMX controlled media server and provides two modes for media playback.
MagicHD Full mode (referred to as MagicHD), is a fully featured 8 layer media server
including layer effects, blending, keystone, and position control of each layer. The DMX
Personality uses one DMX universe for control.

For simpler media playback requirements, MagicHD Quick mode provides a slimline version
of MagicHD which provides a single layer of media playback which also supports transitions
to new media files with a single 7 channel DMX personality.

1.1. Running MagicHD
MagicHD is supported on Windows, macOS, and Linux and is installed as part of the MagicQ
installer. MagicHD can run either as a separate application, known as 'stand-alone', or it can
run as part of MagicQ, known as 'Combined'.

1.1.1. Stand-Alone

MagicHD stand-alone is useful for situations where the device running media is separate to
where MagicQ is running.

• Controlled either via Ethernet using Art-Net, sACN or Pathport, or MagicDMX Full in DMX
input mode.

• Window has simple menus for changing settings, including DMX protocol and address.

• All 8 layers unlocked when a MagicQ console, or a Wing system with encoder wheels, is
detected on the network.

• One layer supported when no MagicQ console or Wing system is detected on the network

• Opens full-screen by default (for quick show startup or recovery).

1.1.2. Combined

MagicHD is built into the MagicQ executable and is launched from the Media Player menu in
MagicQ PC

• Controlled directly by MagicQ.

• All 8 layers always available.

• Starts full screen if a MagicQ Wing is connected, and MagicHD was previously used full-
screen (for quick show startup or recovery)

• Can be selected to render the output of any MagicHD that is patched in the show (e.g. to
see the media output while programming a show).

• Can be used to output to a projector on a second monitor output.
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1.2. MagicHD Modes

1.2.1. MagicHD Full Mode

MagicHD Full mode can display up to 8 media layers (depending on product), one text layer>>
and a final <<output-layer,output layer for overall control of the output. When running stand-
alone when not connected to a MagicQ console or PC+Wing system, MagicHD Full mode will
be limited to only 1 layer. The Combined version of MagicHD built in to MagicQ supports all 8
layers.

Each media layer layer can display one xref:media:media.adoc[media file>> (movie, picture
or audio) and optionally apply a mask. Layers are stacked from 1 (the bottom) to 8 (the top).
Subject to masking and blending, higher layers will hide lower layers. The output layer can
also apply a mask, with the intention that this is used for shuttering, edge blending and
similar projector control effects. You can of course use the masks for anything you wish.

The text layer can display static or moving text. The text is displayed in a window whose
colour, position and orientation can be controlled. Content is supplied as raw text files.

Both the media and output layers can apply a number of colour effects. Effects applied in the
output layer affect the appearance of the whole output.

Conceptually, the output seen by the viewer is the top of a stack of layers:

Top Colour control

Final mask

Text

Media N

…

Media 3

Media 2

Botto
m

Media 1

MagicHD has no in built user interface to control the media output, and this is entirely
controlled by DMX. It does provide a Head Up Display (HUD) which shows useful status
information of the various layers superimposed on the output.

1.2.2. MagicHD Quick Mode

For simpler media playback requirements where only a single fullscreen media output is
required, MagicHD can also run in Quick mode.

This mode allows the playback of a single layer of media with transitions on a simple 7
channel personality.
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1.3. Quick Start

1.3.1. Combined Mode Quick Start

The following instructions assume you are using MagicHD as part of MagicQ PC (the
combined version), and have started a new show with no media servers configured.

When using combined mode, you can patch and configure the media server by going to the
Media window, and selecting the "Server 1" item. In the "Choose Media Server Type" popup,
select MagicHD Full. This will patch and configure a MagicHD Full instance in the show at
universe 1 (or the first free universe if you have heads patched already).

From the Media Player menu, select "View Media Output" to show the MagicHD output
window. Select the MagicHD window, position it in the required screen and press F11 (Mac:
Shift-Cmd-F, Linux: Shift-Ctrl-F) to make it fullscreen.

To control MagicHD, follow the Controlling MagicHD section below.

1.3.2. Stand-Alone Mode Quick Start

To use MagicHD stand-alone on a separate computer to MagicQ via a network protocol,
configure your network output from MagicQ as you would with any other network DMX
devices.

Run the stand-alone version of MagicHD. There will be a shortcut to this alongside MagicQ in
your start menu.

Within MagicHD, select File → Settings, and select the protocol and universe you are
outputting on. For MagicHD Full, as this uses an entire DMX universe, the channel cannot be
selected. For MagicHD Quick mode, the channel will also be selected here. You can also specify
which network adapter to use if you have multiple installed here. For example you may want
to make sure you’re using a wired network connection if your computer has a wired and WiFi
adapter.

Within MagicQ, open the Patch window ⇒ CHOOSE DIM/MEDIA and select MagicHD Full.
Once the MagicHD head has been selected, press PATCH IT, and enter the universe and
channel you want to use for MagicHD and press enter. Note that dependent on your DMX
configuration in MagicQ, the MagicQ universe may not correspond with the universe used on
the network protocol. If asked to auto insert heads into the visualiser, select No.

This has patched the head for the media server, so MagicQ will be able to control it. However
to get live previews and thumbnails, the IP address of your MagicHD instance needs to be
configured.

To configure the IP address, goto Setup > View System > View Media. This should show the
MagicHD server in the first row. Within the IP address column, enter the address of the
computer running MagicHD, and then in the "Thumb connection" column, select "Enabled",
and in the "Live prev" column, select "Yes". This will use the CITP / MSEX protocol to load the
thumbnails from the remote MagicHD instance into MagicQ.
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To control MagicHD, follow the Controlling MagicHD section below.

1.4. Adding Media and Controlling MagicHD
Add your media to MagicHD by selecting the Media Player menu and then "Convert File". This
will allow you to select the media files to be used, and will then ask at which folder and file ID
these files should be saved. Select Folder 001 and File 001 here. If you have already
downloaded the MagicQ sample media, then you may need to select File 004 and above.
MagicHD will then start to process these files in the background.

Once conversion is complete, open the Media window in MagicQ and select the server by
clicking the button now marked "MagicHD".

Initialise the output layer by selecting the "Output" layer box, then pressing the "LOCATE"
softbutton. The first layer can then be used by selecting "Layer 1" and pressing the "LOCATE"
softbutton again. MagicHD should now be displaying the media from Folder 1 File 1 at full
intensity.

As MagicHD processes thumbnails, the thumbnails for each item of media should show up in
the Media window, allowing you to select new files quickly. To change the folder and files, you
can use the X and Y encoders in MagicQ.

1.4.1. Adding a Mask

media → MagicHD → Layer 1 → Mask

then use Mask Folder and Mask File to select a mask. Thumbnails should be displayed for
each folder: simply select the mask by clicking a thumbnail.
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1.4.2. HUD

media → MagicHD → Output → Media

will allow encoder wheel A to select the HUD. Alternatively press and hold HUD Control'' to
bring up soft buttons for each option, or click the top and bottom of HUD Control'' to
cycle through the options.

1.4.3. Keystone

media → MagicHD → Output → Frame

1.4.4. Projector Colour Control

media → MagicHD → Output → Col

Red, Green and Blue encoders control the colour balance of the output.

1.4.5. Displaying Text

media → MagicHD → Text → LOCATE

Use Text Folder / Text File to select your text file. At this point you should see your text.

Use Pos to size and position the text layer (default is full screen)

Use Media → No Of Lines to control how much text is shown in the window

Use Media → Scroll Dir to control how the text scrolls if it doesn’t fit into the window.

1.5. MagicHD Window
MagicHD is launched from the MagicQ PC application via the Media Player menu. It can also
be closed from here, or by closing its window.

The MagicHD window can be positioned and sized just like any other application window.

To go full screen with no borders (i.e. ready for output to a projector):

• select the window and press F11 (Mac: Shift-Cmd-F, Linux: Shift-Ctrl-F)

• in the MagicQ application: menu → Media Player → Full Screen, or

• in the MagicHD application: menu → View → Full Screen.

MagicQ will remember the position and size of the window for when you next open it.

1.6. Adding Media
• From the MagicQ PC application: menu → Media Player → Convert file, or

• From the MagicHD application: menu → Media → Convert file
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• Select the file you want to convert and press Open.

• Select the folder and file you want to convert to.

• Press Convert.

Wait for conversion to take place. Progress is reported on the HUD, and in the input display
window (bottom right) in MagicQ PC.

1.7. Converting Existing Media
• From the MagicQ PC application: menu → Media Player → Convert Media

• From the MagicHD application: menu → Media → Convert Media

Once MagicHD is running, the Convert Media action allows you to force it to convert files
already in the convert folder. This means you can prepare media when MagicHD is not
running. This is worth while if you are preparing a lot of content: if MagicHD is running it
will keep trying to convert files as you edit their names and move them around (unless you
prepare the files elsewhere).


Everything under convert folder will be converted, regardless of file age or
previous conversion status.

1.8. LED Wall
To setup MagicHD with a low resolution output (e.g. an LED wall):

If you are using the stand-alone version, from the menu → View → Output on separate
window.

• From the MagicQ PC application: menu → Media Player → Window…

• From the MagicHD application: menu → View → Window…

• Use the window size dialogue to set the size and position of the window.

• Select No Border

• Select Fixed size.

1.9. Playing Audio
To play media that includes audio:

media → MagicHD → Layer 1 → Locate

then select some media that has audio

media → MagicHD → Layer 1 → Int

set Audio Gain to a non-zero value.
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media → MagicHD → Output → Locate

media → MagicHD → Output → Int

Ensure Audio Volume is not zero.

To change audio output device:

Make sure the MagicHD window is not full screen, so that the menu bar is visible.

From the MagicHD menu: Media → Audio Devices.
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Chapter 2. Configuration

2.1. Configuring MagicQ for use with MagicHD

2.1.1. Stand-Alone Version

To connect to a MagicHD using Art-Net, the MagicQ media server settings should be as
highlighted in this screenshot:

2.1.2. Combined Version

When MagicHD is launched from MagicQ PC it does not use the network. The connection is
direct, within the software. The media server settings ( setup → VIEW SETTINGS → VIEW
SYSTEM → VIEW MEDIA) should be as highlighted in this screenshot:

 The IP address column shows ``Local''. To select Local, enter 0 in that cell.

If you have networked MagicHDs patched in the show, you can use the local window to
duplicate any one of these: from the MagicQ PC application menu: Media Player → Select
Player. A dialogue box will pop up listing all the patched MagicHDs:

<!-- vale BritishSpelling.Spelling = NO --> image::select_player_dlg.png[scaledwidth="33%"] <!--
vale BritishSpelling.Spelling = YES -->


=== The players are listed by name: you should ensure that each player has a
distinct name.

To change a player’s name, go to setup → VIEW SETTINGS → VIEW SYSTEM → VIEW MEDIA.
===
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2.2. The Application Window
Both versions of MagicHD run in an application window like most other software. The
window can be positioned, maximised, minimised and closed, in the usual way. Window
position is remembered from one session to the next.

The window can be moved by simply dragging it with the mouse. This means it can be
positioned even when the border is not present.

If you wish to use MagicHD to drive video output hardware, you can set the window size and
position precisely through the window size dialogue.

2.2.1. Full Screen Mode

In full screen mode MagicHD hides the menu bar, and the mouse cursor when it is inside the
window, so that they do not appear in the projected image during a show.

To enter or leave full screen mode (i.e. a frameless window occupying the whole screen):

• use the keyboard shortcut (the shortcut is also shown next to "Full Screen" in the menus):

◦ Windows F11

◦ Mac Shift-Cmd-F

◦ Linux Shift-Ctrl-F, or

• in the MagicQ PC window: menu → Media Player → Full Screen, or

• in the MagicHD window: menu → Output → Window Position → Change the output type
from the drop down box and select "Fullscreen".

The stand-alone version always starts full screen, ready to start (or continue) a show. This is
because there will not normally be any user interaction with MagicHD. There might not even
be a keyboard connected. To prevent this, select ``Fixed size'' from the output drop down box
in the window size dialogue.

When the combined version detects a PC wing, or other MagicQ console that has encoder
wheels, it also starts full screen, if it was last used in full screen mode. The assumption is that
this setup is part of a show and the user does not want to waste time positioning the window.

Note that on a system with a single screen, if you press F11, the MagicHD window will take
over the screen and the mouse cursor will vanish. This can be confusing because it appears
that you have lost control of the computer. Just press F11 again to leave fullscreen mode.


On macOS, the shortcut Cmd-, (command+comma) brings up the preferences
window even in fullscreen mode.

2.2.2. Split Output Mode

The MagicHD output window can be separated from the application window, so that it can be
positioned independently. This means the menus are still accessible in the main window, even
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when the output window is on a projector or LED wall that might be switched off or too low
resolution to see the menus.

The main window shows status bar shows the network configuration, with DMX health on the
right. A black heartbeat means DMX data is being received. A green heartbeat means the
values are changing. ``No DMX'' flashes when no data is being received.

Split output mode is selected from the menu, and is on by default. This mode is not available
in the combined version because the MagicQ window is always available to control MagicHD.

2.2.3. Settings

MagicHD has only a few user configurable settings. Nearly everything is controlled via DMX.

The DMX settings can be configured by opening the "Settings" dialogue box, the audio output
device can also be selected from here.

Mode

The mode option allows you to switch between the "Full mode" and "Quick mode". Full mode
is for users who wish to use up to use 8 media layers, the output layer and/or the textlayer.
Quick mode for users who wish to be able to have a transition style between media.

The channel setting is only enabled when using "Quick mode".

MagicHD Menu

The MagicHD application window has a simple menu:
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File Settings(1) Change the universe and DMX protocol that
MagicHD responds to

About Version and status information

Exit(1) Close the MagicHD window

Out
put

Window
position

Launch the window size dialogue

Output on
separate
window(1)

Toggle split output mode

Me
dia

Convert all
media

Force conversion of all media in the convert
directory

Convert file Interactively choose a single file for conversion

Stop
conversion

Stop media conversion if it is in progress

Rebuild index Force the media index to be rebuilt

Rebuild
thumbnails

Force all thumbnails to be rebuilt

(1) Only present on the stand-alone version.


To see the menu bar, the window must not be full screen. In full screen mode
the menu bar is hidden.

Combined Version

In the MagicQ PC application window MagicHD settings are accessed from the Media Player
menu:

View Media
Output

Toggle the MagicHD window

Select Player From the patched MagicHDs in the show, select
which one to emulate in the local window

Load MagicHD
Demo

Load the MagicHD demo show, and open the player
window

Window
position

Launch the window size dialogue

Convert all
media

Force conversion of all media in the convert
directory

Convert file Interactively choose a single file for conversion

Stop
conversion

Stop media conversion if it is in progress
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Rebuild index Force the media index to be rebuilt

Rebuild
thumbnails

Force all thumbnails to be rebuilt

Deploy Media TBD

2.2.4. Status

MagicHD is intended to output on a projector or video screen in a show environment,
controlled using DMX. As such there is no mechanism to feed status back to the user. Apart
from the HUD there is no GUI. MagicHD reports warnings, errors and some supporting
information, to its log file, but this is only intended for post mortem analysis.

When there is status to feed back to the user it appears in the status bar on the HUD:

and in the combined version, in the input display window in MagicQ PC:

2.2.5. Window Size Dialogue

The window size dialogue box is launched from the menu. It allows the output window to be
positioned accurately, and its size to be fixed.
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The title of the window shows which screen the output window is displayed in.


The screen’s aspect ratio is not accurate, because the displayed rectangle
stretches with the dialogue box. The window is scaled correctly within the
screen area.

No Border

This option turns off the title, menu and border for the output window. When the border is
hidden, the menus are also hidden. These can either be accessed on the control window if you
are in split output mode, or by pressing the ALT key in the output window. The ALT key
makes the menu appear while pressed. You can then access the menu by pressing one of the
highlighted keys, or by clicking with the mouse.


If you start interacting with the menu it will not automatically hide itself
again. Press ALT again to make it hide.

2.2.6. Always on Top

This option keeps the output window in front of other programs, so it can always be seen.

Output: Fullscreen/Fixed Size

This option fixes the window size on startup. Normally MagicHD will try to start fullscreen.
With this option selected, the last window position and size are remembered and MagicHD
will start with the output window in the same place.
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Live Changes

This option is now a default from version 1.8.9.0 onwards, and can’t be disabled any longer.
This option makes the changes in the dialogue box immediately show in the real window. This
makes interactive fine tuning easier.

 All changes will be saved upon changing them.
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Chapter 3. MagicHD Quick Mode
MagicHD Quick Mode is a slimline version of MagicHD designed for situations where only a
single layer of media playback is required. It supports the ability to perform transitions on the
one layer between the current and next media files all from a single head without the need to
manage multiple layers.

It utilises the same Media Library and conversion process as MagicHD Full Mode, and
integrates with MagicQ, providing thumbnails and easy control via the Media window.
MagicHD Quick Mode also supports integration with an existing MagicQ Cue Stack,
dynamically controlling the transition speed based on the Cue fade time.

3.1. Loading and Patching MagicHD Quick mode
To enable Quick Mode in MagicHD, this can be selected from the MagicHD menu bar under
Media > Quick Mode when using the standalone MagicHD player, or by selecting a MagicHD
Quick server patched in a MagicQ show file. When Quick Mode is enabled and is running in
Standalone mode, you can configure which DMX channel it is patched on using the Settings
dialog box. For the MagicHD Full mode, the DMX Channel is hard coded at channel 1 due to
the size of the DMX personality required.

To patch a MagicHD Quick mode server, go to the Patch window, select CHOOSE DIM/MEDIA >
MagicHD Quick, and continue the patch as normal specifying the universe and channel it is
configured to run on. The Media Server can be named and managed using the standard sheet
in Setup > VIEW SYSTEM > VIEW MEDIA, and should appear as type "MagicHD Quick". An
alternative method patching is to select an unused server in the Media window, and select
"MagicHD Quick" from the popup dialog which appears.

When MagicHD Quick is running as part of MagicQ, then the IP address field in Setup > VIEW
SYSTEM > VIEW MEDIA should be set to "Local". Live thumbnails of the media output are
loaded directly from the server. If MagicHD Quick is running on a separate computer via
network, then Art-Net or sACN can be configured to control the output. Specifying the IP
address of the remote server within the Setup > VIEW SYSTEM > VIEW MEDIA window will
enable live thumbnails to be loaded over the network.

3.2. Usage
Once the MagicHD Quick mode server has been patched, open the Media window by pressing
the MEDIA button, and the MagicHD Quick server should appear in the list of media servers.
As there is only one head file required for the Quick Mode server, selecting the server will
also select the first layer in the Media window.

Media files and folders are selected in the same way as MagicHD Full mode by selecting the
thumbnails of the media or by using the Media File and Media Folder encoders under the
Media attribute group.

When the Media File or Media Folder attribute changes, MagicHD Quick mode will transition
to the new media file based on the current transition and loop settings. A transition type can

16 ChamSys Manuals 2026-02-12



be chosen using the "Transition Type" attribute. If a media file needs to be looped, then the
"Loop" attribute can be used to make the media file repeat indefinitely.

If MagicHD Quick mode will be programmed to a Cue Stack, then setting the Transition Time
channel to 255 will make MagicQ use the Cue Stack fade time as the Transition Time.

When MagicHD detects a Media change, it will use the settings as they were when the
transition was triggered, and subsequent changes to these won’t affect playback.

MagicHD Quick Mode will scale media to fit the current screen size, and will either letterbox
or pillarbox media to preserve their aspect ratio on screen. For finer grained control of
positioning and scale, MagicHD Full mode can be used to apply different scaling modes,
positioning, rotation and sizing to the media.

3.3. DMX Personality
The personality for the Quick Mode head consists of 7 channels.

Parameter Channels Offset Default Type

Intensity 1 0 0 Colour scale

Media Folder 1 1 1 Number

Media File 1 2 0 Number

Transition Type 1 3 0 Quick Transition Type

Transition Time 2 4 0 Quick Transition Time

Loop Mode 1 6 0 Quick Loop Mode

3.3.1. Transition Type

The transitions will use the timing specified in the Transition Time channels.

Value Function

0 Dissolve

1 Slide Down

2 Slide Left

3 Slide Right

4 Slide Up

3.3.2. Transition Time

Transition Time is a two channel attribute allowing selection of a time between 0 and 255
seconds. This maps the coarse channel to be a number of seconds, and the fine channel to be
in 1/256 of a second.

When control of the MagicHD Quick Mode is via a Cue Stack in Cue Timing mode, and the
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Transition Time field is set to 255 or above, then the fade time on the active Cue will be used
to set the Transition Time attribute. This currently works for Cue Stacks in Cue Timing mode,
and not Chase mode currently.

Value (fine - coarse) Transition time

0 - 0 0s

128 - 0 0.5s

255 - 0 1s

0 - 1 1s

0 - 2 2s

0 - 254 254s

255 - 254 255s

0 - 255 Use Cue Stack fade time

255 - 255 Use Cue Stack fade time

3.3.3. Loop

There are two loop modes available to either play the media file once, and stop at the end, or
to repeat the media file on a loop.

Value Function

0 Play Once

1 Repeat
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Chapter 4. Media
Media refers to movies, images, audio, and text files. MagicHD can display all common image
formats, and play almost any format of movie or sound file, although a number of restrictions
apply. If you want to do anything other than play the entire movie forwards at normal speed
the movie must contain only I-frames. This is because playing backwards, skipping frames, or
randomly accessing points within the clip requires that any frame can be displayed by itself.
Performance will also be affected by file size, so consideration must be given to the quality
(i.e. degree of compression) of the media.

Media is always addressed by a pair of DMX channels: folder and file. Wherever a media file
can be selected, you will find the folder/file parameters. If MagicHD can’t make sense of the
selected file, in the context, it will be ignored. For example an audio file could be selected as a
mask, but it will not have any effect because it is not an image. When selecting media, if
either the folder or file is zero,BritishSpellingfSpellingeleNOon'.

<!-- vale BritishSpelling.Spelling = NO -->

MagicHD translates DMX folder/file values into actual filenames by looking in an index file.
For MagicHD to be able to open a media file, the file must be in the index. The index file is
automatically generated and the user is not expected to read or edit it.

4.1. Adding Media
MagicHD is supplied with a library of basic content to get you started, but most users will
want to add their own content. Folders 1 to 9 are reserved for ChamSys libraries, and you are
free to use folders 10 to 255 in any way you like. Folder and file numbers do not have to be
sequential.

Internally MagicHD stores media in numbered folders. Within each folder the file names start
with a number. The folder and file number are the DMX folder/file parameters used to select
that file. An index file is used to tell MagicHD which files to actually use. For MagicHD to be
able to use a new file it must be named correctly, placed in the right folder, and added to the
index. To simplify this process, it is automated:

4.1.1. Automatic Conversion

MagicHD monitors a folder called convert. When media files are added to that folder they are
automatically converted (if required) then moved to the show’s media folders. Once
converted, the files are added to MagicHD’s media index and can be used right away (without
restarting).

Files must be placed in a subfolder, under convert, whose name starts with a number (nnn,
below). This number is taken to be the folder number of the resulting media file. The rest of
the folder name is optional and is ignored by MagicHD. The file’s name must start with a
number (fff, below) then an underscore. This number is taken to be the media’s number
within its folder. The rest of the filename, after the underscore, is copied with spaces
converted to underscores. User folders start from 10 and file numbers start from 1:
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    .../MagicQ PC
          `- convert
                +- nnn_folder_name
                :    `- fff_file_name.mov

Monitoring for new files, and converting them, are background activities and do not impact
playback. MagicHD only looks for changes to files, or the addition of files or folders. Any files
already in place when MagicHD starts will be ignored. To trigger conversion of existing files
just edit the file or folder name: adding or removing a leading zero is sufficient. From the
MagicQ PC menu, Media Player → Convert Media can be used to force MagicHD to re-convert
everything in the convert folder. This can be useful if new media has been prepared in situ
before starting MagicHD. The criteria for triggering conversion (rather than just copying the
media) are:

Movie
content

Action

Non I-frames Converted to a VP9 encoded video with all keyframes.
Note that this process decompresses the video, usually
resulting in a much larger file than the original.

Audio Converted to 2-channel stereo 16 bit PCM if present.

Video codec Any content encoded with the jpeg2000 or cinepak
codecs is converted to VP9. These codecs have been
found to cause problems with thumbnail extraction.

Pixel Format MagicHD can only decode a fixed number of pixel
formats (the representation of colour data within each
frame). Content that uses unknown formats is
converted to VP9 with a known pixel format.

<!-- vale BritishSpelling.Spelling = YES -->

Pictures and text files are copied unchanged, as are any movies or sound files that already
meet the criteria above.

If you wish to exercise full control over the quality and format of your content, prepare it
offline before placing it in the conversion area. If the content meets the basic criteria of all I-
frames and no audio, it will not be converted, thus preserving the original quality and format.

This diagram illustrates the relationship between the convert folder and the resulting media:

User files                      Resulting media

.../MagicQ PC                   .../MagicQ PC
     |                               +- show
     +- convert                          +- media
         +- 10myclips                        +- 010
         |   +- 1_sky.avi                    |   +- 001_sky.avi
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         |   +- 2_planets.mp4                |   +- 002_planets.mp4
         |   `- 3_concert.mov                |   `- 003_concert.mp4 (1)
         +- 011_masks                        +- 011
         |   +- 10_mask1.bmp                 |   +- 010_mask1.bmp
         |   +- 30_mask2.jpg                 |   +- 30_mask2.jpg (2)
         |   +- 30_mask2a.jpg                |   +- 030_mask2a.jpg (2)
         |   `- 40_mask3.png                 |   `- 040_mask3.png
         +- 99text                           `- 099
             +- 001_banner.txt                   +- 001_banner.txt
             +- 2_story.txt                      +- 002_story.txt
             `- 9_orion_lyrics.txt               `- 009_orion_lyrics.txt

Note:

1. 3_concert.mov was converted to .mp4 because it was compressed video.

2. Two files share the same number. MagicHD will always choose the youngest file (i.e. the
most recently converted or added) so 030_mask2a.jpg will be in the index because it will
be converted after 030_mask2.jpg.

None of the following files would be converted, for the reasons given:

.../Magic PC
    +- convert_files
    |   +- 1_one.avi             wrong root folder
    +- convert
        +- 2_two.mp4             not under a numbered folder
        +- clips
        |   `- 3_three.avi       folder has no number
        +- 1_folder_one
        |   `- 4_four.png        only folder numbers 10 to 255 are allowed
        +- 10_new_media
        |   +- five.txt          file has no number
        |   +- 0_six.txt         only file numbers 1 to 255 are valid
        |   +- 7_seven.doc       only .txt files are allowed for text
        |   `- 300_seven.txt     only file numbers 1 to 255 are valid
        +- 20_more_movies
            +- E_eight.mp4       'E' is not a number
            `- 9nine.mp4         number not separated by an underscore

4.1.2. Manual Conversion

To simplify the conversion process you can use the "Convert File" menu option. This allows
you to choose a file, then choose where it goes in the media index. MagicHD will then convert
or copy the file and add it to the index.

4.1.3. Deployment

To simplify deploying the media for a show, and deploying media from one player to another,
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MagicHD performs some automatic housekeeping processes in the background:

• checks for new files in the convert directory

• checks that the index file is present

• checks that there are up-to-date thumbnails for all media.

Because of these automatic checks, it is possible to manage your media content directly in the
show folder by editing the folder and file numbering. When finished, simply delete the index
file and thumbnail folder, then start MagicHD. Alternatively, use the menu options Media →
Rebuild Index and Media → Rebuild Thumbnails.

4.1.4. Notes

Please note the following points:

• Monitoring and conversion take place in the background so that they do not impact media
playback. This means it is possible to add media during a show, but this is not
recommended. It also means conversion, and index or thumbnail regeneration, do not
start immediately.

• MagicHD only checks periodically for new files, out of date index, and missing
thumbnails, so the conversion process will not start immediately when a new file is
added. The conversion process can last a significant time if large movies are involved.

• The conversion process is:

◦ new files are converted,

◦ the index is updated,

◦ out of date thumbnails are regenerated

• While media is being converted, the thumbnails displayed in MagicQ’s media window will
be out of date. Once the thumbnails are ready the combined version will show new
thumbnails as soon as you change folder in the media window. For remote servers, press
the RELOAD THUMBS button (or shift for RELOAD ALL THUMBS):

• Until the index has been rebuilt, MagicHD will not be able to display new media.

• If the contents of an existing file changes, MagicHD will not automatically reload it. To
force a reload, select a different file, then the original one.

• Feedback on progress is displayed on the status line of the HUD, and recorded in the
conversion log file.
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• The results of media conversion are logged in a dedicated log file. For each file, some basic
statistics are reported, and the reason for conversion is logged.

• If you bypass the conversion process, and put new media directly into the show folders,
MagicHD will not get the chance to convert the file format to one that it understands.
MagicHD might not be able to read your media. If you choose to manage media files
directly, make sure you test every file before the show.

4.1.5. Tips

 You can monitor conversion progress by bringing up>> the <<hud,HUD.


To force MagicHD to reload a file that has changed, select a different file,
then select the original one.


To force conversion of an existing file, edit the filename and add/remove a '0'
at the start. This doesn’t change the file’s number, but does cause a change
that MagicHD will notice.

4.1.6. Thumbnail Regeneration

Each media file has a small thumbnail image associated with it. These thumbnails are used by
MagicQ to display the contents of each media folder in the media window.

If any thumbnail file is found to be missing, or older than the corresponding media file, it will
be automatically regenerated.

Media Thumbnail

Movie Frame at 10% duration(1)

Picture The picture

Sound
with

attached
picture(2)

The attached picture

Sound Fixed audio thumbnail

Text Fixed text thumbnail

(1) Note that there is no way for MagicHD to know whether the chosen frame is
representative or useful!

(2) For example, MPEG-4 audio file format (.m4a) supports attached pictures.

 Thumbnail regeneration can be forced from the menu.

2026-02-12 ChamSys Manuals 23

output-layer:output_layer.pdf#hudcontrol


4.1.7. Index Regeneration

If the media index file is missing MagicHD will automatically regenerate it from the media
files in the show.

Note that all media will be included in the index. There is no way to mark a file as not part of
the show, other than obscuring its folder and/or file number (e.g. add '_' or 'hide.' at the start
of the folder or file name).

If multiple files or folders have the same number, MagicHD will take the youngest one. This
favours recently added or changed media. The old media will still be there, but will not be in
the index. This also means that if you make a mistake during conversion or file copying, you
will not lose any media (unless the file name is exactly the same).

 Index regeneration can be forced from the menu.

4.2. Masks
A mask is simply an image whose intensity is used to control the brightness of some other
media behind it. White areas are totally opaque and black totally transparent. Shades of grey
scale between the two. Any image can be used as a mask. Colour is converted to transparency
by taking the black & white intensity of the image. The simplest masks have just black and
white areas, and hide the layer (allowing lower layers to be seen) where they are black.

Each media layer can select a mask whose position is automatically synchronised with the
media for that layer. As the layer is scaled, positioned or rotated, the mask is too. This is the
easiest way to use a masks.

Any media can be used as an independent mask by loading it as the media in its own layer. If
the media has transparency, this will reveal the layer below automatically. If you wish to
control how the mask works, use the Mask colour effect.


Using a layer as a dedicated mask means that movies can be used as masks
as well as images.

The output layer can select a mask which is applied over all the media layers. This can be
used for static effects such as shuttering or edge blending; or dynamic effects that apply to all
layers at once.


For best results create your masks at the same resolution as your media, and
use anti-aliasing to minimise visible pixelation around curves etc.

4.2.1. Examples

If we look at one frame of video and a simple black & white arrow as a mask, the results are
as follows:
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+ =

If we have a more complicated grey scale mask, the effect is as follows:

+ =

And if we use a coloured mask, this is the result:

+ =

The examples above have the mask fully opaque. Reducing the mask’s opacity reduces its
effect. Here is a mask at 0.33 opacity:

+ × 0.33 =

4.2.2. Flipping and Inverting

One image can produce a number of different masks depending on its flip and invert
parameters:

Normal Horizontal Flipped Vertical Flipped H&V flipped

Normal

Inverted

If the same mask is used on two layers, inverted in one, the layers can be blended together as
follows:

Layer 1 + =
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Layer 2 + =

Output Layer

Note that it is not actually necessary to use the mask on layer 1, since layer 2 overlays it
anyway. The effect of the mask in layer 1 is that as layer 2 is faded out, layer 1 retains the
black masked out area.

4.2.3. Notes

Whatever the aspect ratio of an image used as a mask, its ``screen'' is the extent of the media
for that layer. If the mask is stretched to Fill X & Y it will fill the area occupied by the media,
not necessarily the whole screen. This can be overridden by the mask stretch parameter for
the layer.

4.3. Audio
MagicHD can play most common audio formats directly. Audio files should be added just like
any other media.

If audio is present in a movie file, it will automatically be converted to the correct format
when the media is converted (even if the video is already in the correct format). MagicHD will
then play the audio content if the following criteria are met:

Parameter Value

Direction Forwards

Speed Normal (i.e. +1.0)

Mode Once, Once+Black, Loop

Gain > 0

Intensity > 0

Audio Codec 16 bit PCM

MagicHD does not play audio backwards or at different speeds, so Play Mode or speed that
are not compatible will result in the audio output stopping for that layer.

4.3.1. Media Layers

Each media layer has an audio gain>> and an <<_audio_pan,audio pan control. Gain sets the
level for audio playback and should be used to balance the volume of the clip against other
clips in the show. It can be used to boost quiet clips or attenuate loud ones. Pan moves the
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stereo signal from left to right. The volume for each media layer is automatically faded with
the layer’s intensity. Sections of audio-only media can be selected using the start and end
frames, just like any other media. In this case MagicHD uses a simulated 25 frames-per-
second.



• By default, gain for each layer is 0, so that audio is not heard. This is to
prevent unwanted surprises when playing clips that have audio that you
don’t want to hear. You must choose to set the gain above zero to hear
audio.

• Pan uses a 3dB pan law, so a fully panned signal will increase the level in
the L or R channel by 3dB. It doesn’t sound louder because the signal has
gone from the opposite channel, but it might result in clipping if the gain
is already high.

• There is no way to select audio only from a clip that has video. Reducing
the layer intensity to hide the video reduces the audio level too. Use an
external tool to extract the audio from the clip, and play it by itself.

4.3.2. Output Layer

The output layer has an audio volume control. The overall volume of all layers is controlled
by the output layer’s volume, which is also faded with the output layer intensity.

4.3.3. Output Device

The audio output device can be chosen from the MagicHD application menu (Media → Audio
devices). The list of devices is provided by the operating system: MagicHD simply allows the
user to choose one. The output device can be changed while MagicHD is running, but of
course this will interrupt any audio that is playing. MagicHD remembers the selected device
in the show file (combined version) or its settings file (stand-alone version).

If the list of audio devices changes, MagicHD won’t change audio output, but the menu might
not show the right selection. Select a different device to ensure the setting is correct. Similarly,
if the list of devices changes when MagicHD is not running, the setting it has saved in the
show file might be out of synch with the new device list.

4.3.4. Status

The HUD shows audio level superimposed on the layer’s intensity, next to its thumbnail. If the
level is peaking, the display goes bright.

If a layer has audio but it is not being played for some reason (e.g. gain is zero) a "no audio"
icon is displayed over the thumbnail indicating lack of audio.

If a layer has audio but no video an animated thumbnail is shown on the HUD and in the
MagicQ media window. This shows you that an audio file is selected.

 If you are having problems playing audio use the HUD to examine the status.
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Chapter 5. Media Layers
Each media layer can display either a movie, a static image, or play audio. A mask can be used
to control which parts of the layer are visible.

The DMX parameters for the layer allow you to control the following features.

5.1. Intensity
Intensity is used to fade the layer into, or out of, the output. As a layer’s intensity reduces,
lower layers will show through.

Intensity also controls the audio volume for the layer.

5.2. Position
Position controls where the centre of the layer appears in the output.|

5.3. Scale
Scale increases or reduces the size of the layer in the output.

Note that when magnified, low resolution content can look poor.

5.4. Rotation
Rotation allows a layer to be rotated around its centre point. The centre point is controlled by
Position.

5.5. Mirror/Flip
Mirror and flip allow the layer to be flipped (reversed horizontally or vertically), mirrored
(reflected about the centre line, horizontally or vertically), or both.

5.6. Stretch
Stretch controls how the layer fills the screen. Every media file has an associated aspect ratio
and this might not match the aspect ratio of the screen or projector. Stretch controls how the
two aspect ratios are reconciled:

Mode Screen Media Result Note

Fill X Media aspect ratio maintained
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Mode Screen Media Result Note

Fill X Media aspect ratio maintained.
Overflows Y

Fill Y Media aspect ratio maintained.
Overflows X

Fill Y Media aspect ratio maintained.

Fill X &
Y

Media stretched in Y. Aspect ratio lost

Fill X &
Y

Media stretched in X. Aspect ratio lost

5.7. R/G/B
The R, G and B parameters allow the colour balance of the layer to be altered directly.

5.8. Colour Effect
Colour effect, along with the associated R, G and B effect parameters, allows you to alter the
colour of the layer in a number of ways. Full details are in the DMX parameter.

Here are some examples:

Colour
Effect

FX
R

FX
G

FX
B

Result

Posterise 3 3 3 Each of R,G,B quantised to 4 levels.

Colourise 255 130 40 Sepia

Colourise 0 255 0 Black & Green (``night vision'')

Mask 0 - - The layer is used as a mask. The lighter the image, the more
transparent it is. If the image is black and white, white will show
the layer below, and black will not (and will show as black).

Key 85 128 255 ``Green screen'' : any pure green will become transparent.

RGB
Select

3 2 1 RGB → BGR colour swap
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Colour
Effect

FX
R

FX
G

FX
B

Result

RGB
Select

5 6 7 Inverted colour

RGB
Select

8 8 8 Inverted black and white

RGB
Select

0 2 0 Green only (similar to Black & Green)

RGB
Select

0 4 0 Black & Green



A large number of effects are possible, and the best way to understand the
parameters is to experiment.

The ChamSys masks media folder (folder 3) includes an HSL colour chart and
a TV test image. Both of these include solid colours and are very useful for
testing out colour effects.

5.9. Blend
Blend controls how each layer is blended with the one below, in terms of colour and intensity.
Blending takes place from the lowest layer upwards: Layer 2 blends with Layer 1, then Layer
3 blends with the result of 1 and 2, and so on.

Normally layers are simply blended by brightness and transparency: when a layer is
completely opaque (full intensity, no mask), nothing can be seen through it. Normally, as a
layer is faded, it becomes transparent so things below it start to show through. If a mask is
applied, dark areas of the mask make the layer transparent, allowing layers beneath to show
through.

5.10. Folder and File
These allow the media for the layer to be selected. If either are zero, the layer is switched off.

5.11. Start and End Frame
Start and end frame allow frame-wise control of which part of a clip is played. The default
values are a start frame of zero and an end frame of 16777215 (224-1) which mean the whole
file is to be used. If the end frame is less than the length of the clip, playback will stop (or
loop) when the end frame is reached. Similarly playback can be started at any point in the file
by setting the start frame.

To set the start and end frame accurately, you can use the First Frame or Last Frame Play
Mode whilst changing the start or end frame values respectively.

To take complete control of playback speed (e.g. to bounce a clip between two points in time
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to a beat), use First Frame play mode, then apply a ramp effect to the start frame channel.



• Although any values can be set in the DMX channels, the actual start
frame will never exceed the end frame, nor will the end frame ever be
earlier than the start frame.

• If you are using start and end frame to permanently edit a clip (i.e. you
don’t change them or use a different part of the file in another cue),
consider editing off-line since

1. the resulting file will be smaller and

2. using dedicated video editing software can produce better results.

• The values in the DMX channels refer directly to the frame numbers
within the media. Frame numbers run continuously from 0 to the end of
the file.

• The time that a frame number equates to depends on the frame rate of
the file.

• For audio-only <media the frame rate is 25 fps.


Turning on the HUD for the layer being programmed will help since the start
and end frame markers are shown on the media bar.

5.12. Speed
Use the speed parameter to control the speed and direction of media playback. Negative
speeds cause playback in reverse. A speed of 0 stops playback (although see pause mode).

Up to 2 times normal speed, every frame is played. Bear in mind, therefore, that playing an
HD clip x1.9 faster will nearly double the processing load for that layer. Above x2, frames are
dropped to reduce the processing load. There is still an increased load for all but whole
number multipliers: at x4.7, 3 out of every 4 frames are dropped, so the remaining load is
x1.7.

Since there is an inherent loss of quality at high playback speeds (because the human brain
can’t process the imagery so well), consider the quality and resolution of the source material
carefully.

5.13. Play Mode
Play mode allows a movie clip to be played in a number of different ways:

5.13.1. Once

The movie is played one, from the start frame to the end frame, controlled by the speed
parameter.

Playback finishes on the last frame, which is held. If playback is in reverse (negative speed)
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the last frame is actually the start frame.

5.13.2. Once Then Black

The same as Once, except the layer automatically blacks out after the last frame. This removes
the need to set, and accurately time, a second cue to fade the layer at the end.

5.13.3. Loop

The same as Once, except playback loops to the first frame after the last frame.

When playing forwards, first = start and last = end. When backwards, first = end and last =
start.

5.13.4. Bounce

The same as Loop, except the direction automatically changes each time.

Note that the speed parameter is automatically reversed, so that changes in magnitude do not
suddenly reverse the direction if the sign of the speed does not match the direction. i.e. once
the first reverse has taken place, only the magnitude of the speed parameter has any effect
unless the speed crosses zero, where the direction of bounce would also change.

5.13.5. Once, Restart after Intensity 0

The same as Once however playback jumps back to the first frame when intensity is reduced
to 0 and then increased.

5.13.6. Once Then Black, Restart after Intensity 0

The same as Once-then-black however playback jumps back to the first frame when intensity
is reduced to 0 and then increased.

5.13.7. Loop, Restart after Intensity 0

The same as Loop however playback jumps back to the first frame when intensity is reduced
to 0 and then increased.

5.13.8. Bounce, Restart after Intensity 0

The same as Bounce however playback jumps back to the first frame when intensity is
reduced to 0 and then increased.

5.13.9. First Frame

The current first frame is always shown. Although playback is therefore not ``dynamic'', the
start frame parameter can be altered in real time to control playback.
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5.13.10. Last Frame

The current last frame is always shown. Although playback is therefore not ``dynamic'', the
end frame parameter can be altered in real time to control playback.

5.13.11. Pause

Playback is paused at whatever the current frame is. This mode can be used in conjunction
with other modes, and cues, to achieve more complex playback effects. For example it allows
playback to be paused without setting the speed to zero, so playback can be restarted with the
previous speed. The ``resume'' cue does not need to have the playback speed programmed.

5.13.12. Next Frame

Advances the frame that is displayed, according to the speed parameter (i.e. direction and
frame skipping for high speeds still apply), then automatically pauses. The mode must be
changed away (e.g. to Pause), then back, before this mode can change the frame again.


Pause can be used in conjunction with Next Frame (or other modes) to
achieve more complex playback effects such as moving through a slide show.

5.14. Transition
Not implemented yet.

5.15. Mask Opacity
This parameter controls how opaque the mask is. If the opacity is full, the mask has complete
control over the transparency of the layer. As the opacity is reduced, the mask has less effect:
black areas that would have been completely transparent becomes less so, allowing less of the
lower layers to show through. As opacity reduces to zero, the mask is effectively switched off.

5.16. Mask Folder and File
These allow the mask for the layer to be selected. If either are zero, no mask is selected. If a
non-image file is selected (i.e. a movie, audio or text file) the mask will have no effect.

5.17. Mask Invert
This parameter allows the intensity of the mask to be inverted. This means that what would
be fully transparent becomes fully opaque and vice-versa.

The same mask can be used in two layers, inverted in one layer, to produce synchronised
masking effects, as shown in this example.
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5.18. Mask Mirror/Flip
This allows the orientation of the mask to be controlled independently from that of the media
file for the layer.

If anything other than this simple level of control is required, the mask must be used by itself
in a different layer so that it can be independently positioned and rotated.

5.19. Mask Stretch
This parameter governs how the aspect ratio of the mask image is matched to that of the
layer’s media. As far as the mask is concerned, the screen that it is being stretched to is
actually the media file. If, for example, the media is appearing letter-boxed, setting mask
stretch to Fill X & Y stretches the mask to the same extent as the media thereby altering the
mask’s aspect ratio.

5.20. Audio Gain
This parameter controls the audio level for the layer. A gain of zero turns off the audio
playback. Note that the range is 0 to 10. For most purposes 0.5 to 2.0 will suffice. High gains
can be used to boost very quiet clips.

This parameter is mainly intended to allows clips with different peak levels to be equalised.

5.21. Audio Pan
This parameter allows the stereo image to be moved from left to right.

5.22. Physical Effect
This parameter allows a variety of physical effects to be applied to the layer, independently
from the Colour Effect. Full details are in the DMX parameter.
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Chapter 6. Text Layer
The text layer displays the contents of the chosen text file over the top of the other media
layers.

Text is displayed in a rectangular window, which by default occupies the whole screen. If
position and scale are set to something other than full screen, the result is a text ``window''
appearing over the media layers. The chosen text is sized to fit this window. If the resulting
text overflows the window, it is clipped (but can be scrolled). The text lines parameter
controls how much text is shown in the window.

The colour of the window background, and its transparency, can be altered, giving control
over the contrast and visibility of the text, when viewed over media.

The Text Layer expects media in the form of .txt files. When adding your own media, only this
type of file will be converted. Although text files traditionally use just the ASCII character set,
MagicHD can read and display extended characters if they are present in the text file.

The DMX parameters for the layer allow you to control the following features.

6.1. Intensity
Intensity is used to fade the layer into, or out of, the output. As the layer’s intensity reduces,
the text will become less visible.

6.2. Position
Position controls where the centre of the text layer appears in the output.

6.3. Scale
Scale increases or reduces the size of the text layer in the output.

6.4. Rotation
Rotation allows the layer to be rotated around its centre point. The centre point is controlled
by Position.

6.5. R/G/B
These parameters control the colour of the text.

6.6. Background R/G/B
These parameters control the colour of the text background. When the text layer is positioned
smaller than full screen, the edges of the text window becomes visible, and you will notice the
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background colour of the layer.

6.7. Background Transparency
This parameter controls how transparent the text background is.

To ensure text can be seen over any media, transparency can be set to 0, but this will
completely block out what is behind the text window. A more gentle effect is to set the
transparency to something between 25% and 50%, giving some contrast for the letters, but
allowing the <media beneath to show through.

Setting transparency to 255 effectively removes the text background. In this case the choice of
text colour is important since it must be visible over the media layers.

RGB Background Transparency Result

0,255,0 0,0,255 0

255,128,0 128,128,0 100

255,0,128 0,0,0 255

6.8. Text Folder and File
These allow the text for the layer to be selected. If either are zero, the layer is switched off.
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6.9. Font
This parameter allows the text font to be changed. Built in fonts are as follows. User defined
fonts are not supported yet.

Number Font Bold Italic

0 Arial

1 Arial X

2 Arial X

3 Arial X X

4 Courier

5 Courier X

6 Courier X

7 Courier X X

8 Times New Roman

9 Times New Roman X

10 Times New Roman X

11 Times New Roman X X

12 Script

13 Script X

14 Script X

15 Script X X

16 Georgia

17 Georgia X

18 Georgia X

19 Georgia X X

20 Impact

21 Impact X

22 Impact X

23 Impact X X

6.10. Text Lines
This parameter controls the number of lines of text that are displayed vertically within the
text window. With a given position and scale for the layer, increasing the number of lines
means the size of the text will reduce so that the required number of lines fit. When set to
zero, all the text is displayed.
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Lines Result

0

1

3

10

17(*)
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(*) The text is 13 lines high, but because of the size of the window, and the width of the text, it
needs a setting of 17 lines before the full width of the text is visible.


For text with lots of lines, when text lines is set to 0, all the lines are shown
and could result in very small font size.

6.11. Scroll Direction
This parameter controls the direction for scrolling text. Text will only scroll horizontally if it
does not fit across the window, or vertically if it does not fit the height of the window. If the
direction is set to Char/Line the position of the text can be controlled regardless of its size.


For advanced scrolling effects, set Scroll Direction to Char/Line and control
the character (X) and line (Y) directly from the console. Make sure scroll time
is zero otherwise this will delay the changes.

6.12. Scroll Speed
This parameter controls the speed of scrolling. For horizontal scrolling the value is characters
per second, and vertically, lines per second.

6.13. Loop
This parameter controls how the text behaves when it is scrolling, and what happens when
the text has scrolled to the maximum extent.

6.14. Scroll Char
When scroll direction is set to Char/Line this parameter selects the character that is displayed
in the top left corner of the text window. Note that variable width fonts this will not be
precise. The character spacing is based on the average character width over the whole piece
of text. The start of the line is character 0. Positive numbers scroll the text to the left and
negative numbers scroll the text to the right.

When this parameter changes the text will be scrolled to the new value immediately.

6.15. Scroll Line
When scroll direction is set to Char/Line this parameter selects the line that is displayed at
the top of the text window. The top of the text is line 0. Positive numbers scroll the text up and
negative numbers scroll the text down.

When this parameter changes the text will be scrolled to the new value immediately.
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6.16. Scroll Time
This parameter controls how fast the text scrolls when scroll direction is set to Char/Line. The
range is from 0 to 10 seconds. Every time scroll char or scroll line changes the scrolling re-
starts and will complete after this amount of time.

6.17. Border
This parameter controls the width of the border between the edge of the text window and the
text itself. The range is 0 to 0.25, and represents the border width as a proportion of overall
text window size.

Border Result

0

0.1

0.25
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Border Result

0.25(*)

(*) This example shows how the text fades towards the edge of the window if it extends into
the border zone. Here the text has been scrolled to a char/line position in the middle of the
text.
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Chapter 7. Output Layer
The output layer is used to control the overall appearance of the output from MagicHD. The
output layer acts on the sum total of the media and text layers: they are effectively combined
into one resulting image, which the output layer then manipulates.

Note that any setting that puts all or part of the output beyond the limits of the window,
screen or projector output will result in those parts of the output being clipped.

The DMX parameters for the layer allow you to control the following features.

7.1. Intensity
Intensity controls the overall brightness of the MagicHD video output.

Intensity controls the overall volume of the MagicHD audio output.

7.2. Position
Position controls where the MagicHD output appears within the window, screen or projected
area.

7.3. Scale
Scale increases or reduces the size of the output.

7.4. Rotation
This parameter allows the output to be rotated within the extent of the window, screen or
projected area. The centre point is controlled by Position.

7.5. Mirror/Flip
This parameter allows the output to be flipped horizontally, vertically or both.

7.6. R/G/B
The R, G and B parameters allow the colour balance of the output to be altered directly.


This alters all layers at the same time. For control of individual layers, use
the colour parameters for that layer.

7.7. Colour Effect
Colour effect, along with the associated R, G and B effect parameters, allows you to alter the
overall colour of the MagicHD output in a number of ways.
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These work in exactly the same way as for the Media Layers.


This alters all layers at the same time. For control of individual layers, use
the colour effect parameter for that layer.

7.8. Mask Folder and File, Invert, Mirror/Flip
The output layer can optionally use a mask to achieve shuttering, edge blending, scenery
blanking, or other effects. The mask is automatically stretched to fit the output layer and its
opacity cannot be controlled.

The mask parameters work in exactly the same way as the Media Layer mask parameters
folder/file, invert>> and <<_mask_mirror_flip,mirror/flip.

7.9. Keystone
The keystone parameters apply keystone distortion to the output image:

→

The 8 keystone parameters move the corners of the image within the output screen:

The range of each parameter is the full screen width or height, with bottom left at (0,0) and
top right at (1,1). Parameter names match the encoder wheels on MagicQ consoles.
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
When setting up keystone it can help to turn on the HUD grid as shown in
these screenshots. The grid also enables keystone configuration with no
media playing.

7.10. HUD Control
The HUD control parameter turns the HUD overlay on and off, and selects which layer’s DMX
parameters are displayed. It is a bitmask, and details are given in the DMX parameter
description.

7.11. Audio Volume
This parameter controls the overall volume of audio from all media layers. Audio volume is
faded with output layer intensity. Therefore DBO also kills audio output.

7.12. Physical Effect
This parameter allows a variety of physical effects to be applied to the layer, independently
from the Colour Effect. Full details are in the DMX parameter.
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Chapter 8. Pixel Mapping

 MagicHD pixel mapping is enabled from version 1.7.3.0

DMX output is supported from MagicHD when running from within MagicQ.

The video output, or a specific layer, can be applied over a two-dimensional grid of lighting
fixtures.

Features

• Uses the 'GRID' window inside MagicQ software

• Up to 10 grids and 64 universes of output (or 127 with a dongle connected)

• Individual MagicHD layers can be mapped to each grid

• Width, height, position and colour adjustment per grid

• Intensity adjustment per grid

• Pixel mapping enable/disable and intensity macros can be added to cues

• Ability to run pixelmapping without the video output window open

Limitations

• Up to 10 grids

• Maximum grid width and height of 1024

• Not supported on standalone MagicHD

Console Support

As well as the PC download of MagicQ, pixel mapping is included in the MQ500.

There is currently no option to send MagicHD output directy to the external monitor on
consoles, however you can use the 'MAGICHD PIXMAP' window to preview the output (see the
'Advanced settings' section below).

8.1. Getting Started
The best way to start is by using MagicQ to load the demos/Training.shw show, as this already
has 1 grid.

You will need to setup a new media server - go to 'MEDIA' and double click on the next empty
server, "Server 2", choose "MagicHD".

Open the visualiser so you can verify that everything is working - use the top menu bar to
select 'Visualiser' > 'View visualiser'. You will need to turn beams off as this makes the pixel
mapping easier to see; go to 'File' > 'Settings' in the visualiser and check "Don’t draw any
beams".

Back in the 'MEDIA' window, select "MagicHD", "Output" and click on 'LOCATE', then select
"Layer 1" and click on 'LOCATE'. This will turn on a test card.
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Go to the 'OUTPUTS' > 'VIEW PLAN' window. Click on encoder E to turn on the pixelmapper
for grid 1. You may have to wait a few seconds while MagicHD starts up in the background;
you should then see the test card in the visualiser.

8.2. Advanced Settings
The steps above use encoder E in the 'OUTPUTS' window to turn on pixel mapping; this will
use the default settings: output layer, full size and full intensity.

For more control you will need to open the 'MAGICHD PIXMAP' window from the top menu
bar, under 'Window' (Alt + 'MEDIA' on consoles). This window shows a preview of MagicHD
inside MagicQ, allowing you to view any layer without requiring the video output window to
be open.

This window has three modes:

MAGICHD PREVIEW

Shows the current MagicHD output. Use encoder A to switch between layers.

PIXMAP SETUP

Use encoder A to switch between grids, and encoder B to turn pixel mapping on or off for the
selected grid.

The rest of the encoders allow setting the MagicHD layer, flipping, colour and intensity
adjustment.

The window will show a full size preview of the selected layer, overlayed with boxes
representing the posistion and size of the grid. By default the grid is applied over the entire
video area.

PIXMAP EXPANDED

This allows you to adjust the dimensions of the grid. The preview area zooms in to show just
the area of the video being applied to the grid.


No preview will be shown if MagicHD is not running. See the 'Starting
MagicHD' section below.

8.3. Cue Macros
PX 1/0 turns off pixel mapping for grid one.

PX 1/100 turns on pixel mapping for grid one and sets intensity to 100%.

PX 2/50 turns on pixel mapping for grid two and sets intensity to 50%.

8.4. DMX Output Priority
Pixel mapping output overrides all other playbacks controlling the same DMX channels.
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8.5. Starting MagicHD
The MagicHD engine will automatically start in the background when a show is opened with
pixel mapping enabled for at least one of its grids. Otherwise, it will start the first time pixel
mapping is turned on, or when the output window is opened.
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Chapter 9. Head Up Display
The HUD allows the user to see live control data, and the status of the media player, overlaid
on the projected output.

The HUD is always displayed on top of the output layer, and does not have any colour effects
applied to it. It does get keystoned. It displays a border round the entire screen so that you can
see the full extent of the projection area even when the output has been modified, distorted,
or turned off. This allows a projector to be aligned even without media. Unless you are
projecting on a very irregular surface, you should always be able to see the HUD no matter
what configuration has been applied to the other layers.

The DMX channel that controls the HUD allows it to be positioned left, centre or right of
screen; and selects the layer whose DMX data is shown.

Thumbnails of each layer are shown, whether or not they are visible in the output. This
allows the user to see all the content that is making up the output, not just what is visible.

Changing DMX parameters are highlighted, as are illegal/erroneous values. The raw DMX
channel data is shown, along with the converted value (e.g. angle is shown as a 16 bit value,
and also as the resulting angle in degrees). This helps you to understand the effect that the
parameters have on the output.

The HUD can also display a grid to help with projector alignment and keystoning. Like the
normal HUD display, the grid is not subject to output intensity or colour control, and appears
whether or not any media is displayed.

9.1. HUD Anatomy
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The top part of the HUD displays the DMX parameter for the selected layer. Each parameter
occupies one row.

Below the DMX data are the layer thumbnails. These are updated live and show the content of
each layer individually. Next to each thumbnail is a bar indicating the intensity of that layer.
In the example above, layers 1 to 4, and the text layer, are programmed. The thumbnail of the
resulting output layer can be seen, even though its intensity is 0.

The colour bars are part of the HUD to ensure that there is always full colour in the output no
matter which effects have been applied. This gives confidence in what is being output to the
projector.

Whenever a media layer is showing moving content, the media bar is displayed. This shows
dynamic information about the movie.

The bottom right area shows static configuration information. This typically doesn’t change
unless the system is re-configured and the player restarted.
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Chapter 10. Troubleshooting

10.1. Blank Screen
If MagicHD starts with a blank screen and you can’t get media to display:

• If you are running MagicHD on the same PC as MagicQ

◦ you must launch MagicHD from within MagicQ. The MagicHD window title will show
MagicHD (Server 1 `MagicHD') or something similar

◦ you must ensure the media player is configured correctly.

• If you are running MagicHD on its own PC:

◦ the MagicHD window title will show MagicHD (Art-Net universe 0) or something
similar

◦ you must patch MagicHD to an Art-Net universe that is being output by MagicQ

◦ you must ensure the media player is configured correctly.

◦ you must tell MagicHD to use the right universe. The protocol and universe are
changed under File → Settings in the MagicHD application menu.

• If the MagicHD window has filled the screen and hidden other applications you can leave
full screen mode by

◦ on a PC press F11 to leave fullscreen, or Alt-Tab to cycle round your applications

◦ on a Mac press Cmd-Shift-F, or Cmd-Tab to cycle round your applications. Although
you can’t see the mouse pointer, if you move it to the extreme top right the application
menu bar should re-appear, including the fullscreen button which you can press to
leave fullscreen.

10.2. Media Conversion

10.2.1. New Files Are Not Being Converted

For MagicHD to spot a new media file that needs to be converted, the file must be in the right
place.

• Does the filename start with a number and underscore? e.g. 001_example.mov

• Is the file in a numbered directory? e.g. 99/001_example.mov

• Is the directory in the convert folder? e.g Documents/MagicQ/convert/99/001_example.mov

Check for the new file in the show. Continuing the example above, you should see
Documents/MagicQ/show/media/99/001_example.mov

If the new media file is not getting converted, you might see an error message flash up on the
HUD or MagicQ input window. Even if you miss this, there is a conversion log file. Check here
for warnings or errors.
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
To make it easier to analyse the log file restart MagicHD and try the
conversion by itself. The log file will be small and should only contain
messages relating to the problem file.

10.2.2. MagicHD Won’t Play New File

For MagicHD to play a media file it must be in MagicHD’s index. The automatic conversion
process normally does this for you. If media has been added directly, or conversion was
interrupted, the index file might be out of date. To ensure the index is right, either delete the
index file or regenerate it via the menu.

If you still can’t play the media check in the MagicHD log file for errors or warnings.


To make it easier to analyse the log file restart MagicHD, locate the output
layer and layer 1, then in layer 1 select the problem media file. The log file
will be small and should only contain messages relating to the problem file.

10.3. Thumbnails
The most common cause of incorrect or missing thumbnails is a mismatched network
configuration. This only applies to the standalone configuration. Symptoms include

• Missing thumbnails

• Out of date thumbnails

• No result from RELOAD THUMBS or RELOAD ALL THUMBS in the media window

Thumbnails are retrieved via the CITP/MSEX protocol which requires both peers (in this case
MagicHD and MagicQ) to be able to ``see'' each other. Normal control of MagicHD is via Art-
Net which is a broadcast protocol. Traffic is one way (MagicQ to MagicHD) and does not
require MagicHD to be in contact with MagicQ.

10.4. Network Configuration
The PC running MagicHD, and the MagicQ console, must both have their IP address and
netmask set so that they are on the same subnet. For example:

MagicHD IP Address 10.0.0.100
Netmask 255.0.0.0

MagicQ IP Address 10.0.1.1
Netmask 255.0.0.0

Both machines are on the 10.x.x.x subnet so they should be able to see each other.

To test this, ping MagicHD from MagicQ and vice versa:

• In MagicQ, type ``…'' followed by the IP address of the MagicHD PC. The result is
displayed in the input window.
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• On the MagicHD PC, open a DOS box, terminal or equivalent and type ``ping'' followed by
the IP address of the console.

If you have multiple network adapters, make sure you are looking at the settings for the right
one. You can find out which address MagicHD is using by selecting Settings or About from
the application menu.

Once the networks settings are correct, MagicQ must be configured to talk to MagicHD. The
Con State entry should show ``Connected''.

Keystone
If you can’t see your media, and get a collection of letters on the screen like this

your keystone parameters are causing one corner of the media to be folded over. The letters
correspond to the 8 encoders that control the position of the 4 corners. The side(s) of the
media rectangle are shown in green where they are OK, and red where they are invalid. In
this example the corner (A,B) has moved inside the line from (C,D) to (E,F). As you change the
encoders you should see the corner points move. As soon as the keystone area is valid the
media will appear again.



• A quick way out is to LOCATE the output layer. This sets all parameters
back to default.

• If the problem persists check that you are using the latest head file for
the MagicHD output layer. The personality changed in version 1.6.1.6.

10.5. No Text
If you have recently added a text file you need to re-index the media before MagicHD will
display the file.

The display of different fonts depends on the underlying operating system. If a particular font
is not installed, or can’t be displayed at large point sizes, the text might vanish. To overcome
this select a different font. Font 0 should always display.
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
A quick way to test the text layer is to LOCATE it. This sets all parameters
back to default. Then select the text file you want, then alter other
parameters to get the desired effect.

10.6. No Live Preview
If MagicQ is not showing live previews from MagicHD the most common cause is the network
configuration on the MagicHD machine. Previews are sent by multicast so there must be a
network route from MagicHD to MagicQ for the network packets to reach the console.

The simplest way to fix this problem is to add a default route, on the MagicHD machine, that
uses the Ethernet connection to MagicQ. Instructions for showing and setting network routes
are highly OS specific so you are advised to search the internet for details.
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Chapter 11. DMX Personality
Note that all multi-channel parameters are read big-endian. i.e. coarse setting followed by
fine.

Parameters shown in italics are reserved but not currently implemented.

11.1. Universe
The MagicHD personality has been designed to fit within a single universe of DMX.

Block Channels Offset

Output layer 50 0

Text layer 33 50

reserved 17

Layer 1 42 100

reserved 8

Layer 2 42 150

reserved 8

Layer 3 42 200

reserved 8

Layer 4 42 250

reserved 8

Layer 5 42 300

reserved 8

Layer 6 42 350

reserved 8

Layer 7 42 400

reserved 8

Layer 8 42 450

reserved 8

spare 12

11.2. Output Layer

Parameter Channels Offset Default Type

Intensity 1 0 0 Colour scale

Position X 2 1 32768 Screen offset
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Parameter Channels Offset Default Type

Position Y 2 3 32768 Screen offset

Scale X 2 5 32768 Scale

Scale Y 2 7 32768 Scale

Rotation 2 9 32768 Angle

Mirror/flip 1 11 0 Mirror / flip

Red 1 12 255 Colour scale

Green 1 13 255 Colour scale

Blue 1 14 255 Colour scale

Colour effect 1 15 0 Colour effect

FX parameter R 1 16 0 Number or Colour Scale depending on
effect

FX parameter G 1 17 0 Number or Colour Scale depending on
effect

FX parameter B 1 18 0 Number or Colour Scale depending on
effect

Mask folder 1 19 3 Number

Mask file 1 20 0 Number

Mask invert 1 21 0 Flag

Mask mirror/flip 1 22 0 Mirror / flip

Keystone A 2 23 0 Keystone

Keystone B 2 25 65535 Keystone

Keystone C 2 27 0 Keystone

Keystone D 2 29 0 Keystone

Keystone E 2 31 65535 Keystone

Keystone F 2 33 65535 Keystone

Keystone X 2 35 65535 Keystone

Keystone Y 2 37 0 Keystone

HUD control 1 39 0 HUD control bitmask

Audio Volume 1 40 255 Audio scale

Physical effect 1 41 0 Physical effect

Phys FX parameter
1

1 42 0 Number or Scroll Speed depending on
effect

Phys FX parameter
2

1 43 0 Number or Scroll Speed depending on
effect
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Parameter Channels Offset Default Type

Phys FX parameter
3

1 44 0 Number or Scroll Speed depending on
effect

reserved 3 45

Control Function 1 48 0 Control Function (MagicHD Box only)

Control Enable 1 49 0 Control Enable (MagicHD Box only)

11.3. Text Layer

Parameter Channels Offset Default Type

Intensity 1 0 0 Colour scale

Position X 2 1 32768 Screen offset

Position Y 2 3 32768 Screen offset

Scale X 2 5 32768 Scale

Scale Y 2 7 32768 Scale

Rotation 2 9 32768 Angle

Red 1 11 255 Colour scale

Green 1 12 255 Colour scale

Blue 1 13 255 Colour scale

Background red 1 14 0 Colour scale

Background green 1 15 0 Colour scale

Background blue 1 16 0 Colour scale

Background transparency 1 17 192 Colour scale

Text folder 1 18 5 Number

Text file 1 19 0 Number

Font 1 20 0 Number

Text lines 1 21 1 Number

Scroll direction 1 22 0 Direction

Scroll speed 2 23 0 Speed factor

Loop 1 25 0 Text loop mode

Scroll char 2 26 10005 Scroll position

Scroll line 2 28 10005 Scroll position

Scroll time 2 30 0 Duration

Border 1 32 0 Number
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11.4. Media Layers

Parameter Channel
s

Offset Default Type

Intensity 1 0 0 Colour scale

Position X 2 1 32768 Screen offset

Position Y 2 3 32768 Screen offset

Scale X 2 5 32768 Scale

Scale Y 2 7 32768 Scale

Rotation 2 9 32768 Angle

Mirror/flip 1 11 0 Mirror / flip

Stretch 1 12 0 <<_layer_stretch_mode,Layer stretch
mode]

Red 1 13 255 Colour scale

Green 1 14 255 Colour scale

Blue 1 15 255 Colour scale

Colour effect 1 16 0 Colour effect

FX parameter R 1 17 0 Number or Colour Scale depending on
effect

FX parameter G 1 18 0 Number or Colour Scale depending on
effect

FX parameter B 1 19 0 Number or Colour Scale depending on
effect

Blend 1 20 0 Blend type

Folder 1 21 0 Number

File 1 22 1 Number

Start frame 3 23 0 Number

End frame 3 26 1677721
5

Number

Speed 2 29 39321 Speed factor

Play mode 1 31 2 Play mode

Transition 2 32 0 Transition type

Mask opacity 1 34 0 Colour scale

Mask folder 1 35 3 Number

Mask file 1 36 1 Number

Mask invert 1 37 0 Flag
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Parameter Channel
s

Offset Default Type

Mask mirror/flip 1 38 0 Mirror / flip

Mask stretch 1 39 0 Layer stretch mode

Audio Gain 1 40 0 Audio scale

Audio Pan 1 41 128 Audio pan

Physical effect 1 42 0 Physical effect

Phys FX parameter
1

1 43 0 Number or Scroll Speed depending on
effect

Phys FX parameter
2

1 44 0 Number or Scroll Speed depending on
effect

Phys FX parameter
3

1 45 0 Number or Scroll Speed depending on
effect

11.5. Parameter Types
The best way to understand the effect of parameters is to turn on the HUD, watch the
corresponding parameter change as you turn an encoder wheel, and see the effect on the
output.

11.5.1. Angle

Angles are specified by two consecutive DMX channels, with the values 0-65535 representing
the range -180° to +179.995°. One bit is 0.0055°. 32768 is 0.0°. Positive rotation is clockwise.

11.5.2. Audio Pan

Audio pan controls stereo panning using a linear scale of 0-255 with 0 representing full left,
128 centre, and 255 full right. 128 is the default.

11.5.3. Audio Scale

Audio scale controls audio parameters using a linear scale with the values 0-255 representing
the range 0 to 1.0.

11.5.4. Blend Type

When blending two layers together, the colour of each pixel in the resulting image is
controlled by the blend setting.

Valu
e

Effect Notes

0 Normal Layers are blended by their
intensity.
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Valu
e

Effect Notes

1 Add Colour The higher layer is added to the
lower layer.

2 Subtract
Colour

The higher layer is subtracted from
the lower layer.

3 Max Colour The result uses the highest value
from each layer.

11.5.5. Colour Effect

Colour effect is usually accompanied by up to 3 additional parameters called FX-R, FX-G and
FX-B.

Val
ue

Effect Notes

0 None

1 B&W

2 RGB
select

FX parameters are numbers, selecting the mapping for R,G and B colour
channels as follows:

0 Black

1 R

2 G

3 B

4 Intensity(1)

5 inverse R

6 inverse G

7 inverse B

8 inverse intensity(1)

3 Posteris
e

FX parameters are numbers, selecting the number of colour steps for R,G and
B:

0 1 step, i.e. 1 bit colour.

1

2 2 steps

…

255 255 steps, i.e. normal

4 Colouris
e

FX parameters are colour scale values, controlling colourisation of the basic
B&W image.
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Val
ue

Effect Notes

5 Mask(2) Use the layer as a mask. FX-R selects the mode:

0 Transparency = intensity(1), colour unchanged.

1 As 0, with inverted colour

2 Transparency = inverse intensity(1), colour unchanged

3 As 2, with inverted colour

4 Transparency comes from the media’s alpha channel. Opaque
pixels become fixed colour.

FX-G Hue 0-254 Hue(5)

255 White.

FX-B Lightness 0 is black, whatever hue is
chosen.

5 Transparency = intensity(1), colour as for 4(6).

6 Transparency = inverse intensity(1), colour as for 4(6).

6 Key(2)(3) Chroma Key. FX parameters are colour scale values, specifying the colour to
match. The matched colour is made transparent.

FX-R Hue(5).

FX-G Selectivity 0 Narrow

255 Wide

FX-B Transparency 0 Gradual

255 All transparent

7 Hue
Offset(4)

FX-R controls the hue offset:

0 0° No effect

128 180° Turns red into cyan, yellow into blue etc.

255 360° No effect

8 Hue
Filter(4)

Apply a bandpass filter to the hue. Filtered out hue becomes black & white.

FX-R Hue(5).

FX-G Selectivity 0 Narrow

255 Wide

FX-B Fall-off 0 Triangle

255 Square

9 Invert Invert RGB.

Shortcut for RGB select with parameters (5,6,7).

10 Curve 1 Not implemented yet.
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Val
ue

Effect Notes

11 Curve 2 Not implemented yet.

12 Curve 3 Not implemented yet.

(1) Intensity is the overall brightness of the image; effectively the black & white version of it.

(2) Not implemented in the output layer, because it is an inter-layer effect.

(3) The best way to understand this effect is to select some media in layer 1, then select the
HSL image from folder 3 (masks) in layer 2, then play with the effect parameters.

(4) The best way to understand this effect is to select the HSL image from folder 3 (masks)
then play with the effect parameters.

(5) Hue refers to the HSL colour model

(6) Leave Hue and Lightness at 0 for no colour, so that the mask just controls the transparency
of the layer below.

11.5.6. Colour Scale

Colour, intensity, transparency etc. are specified by a linear scale with the values 0-255
representing the range 0 to 1.0.

11.5.7. Control Enable

This parameter must held at 255 while Control Function is programmed.

 This parameter is only applicable to the MagicHD Box product.

11.5.8. Control Function

Any setting must be held for at least 5 seconds, with Control Enable enabled, before the
corresponding function will happen.

Value Function

0 No Function

1-10 Turn Off

11-20 Standby

21-30 Turn On

31-40 Reboot

 This parameter is only applicable to the MagicHD Box product.
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11.5.9. Direction

Direction (e.g. for scrolling) is encoded as follows:

Val
ue

Direc
tion

Notes

0 None Stops scrolling but does not reset
position

1 Left

2 Right

3 Up

4 Dow
n

5 Char/
Line

This mode allows text to be
scrolled in X/Y simultaneously, to
any position.

6 Top
Left

Resets scroll position to top left
and stays there

11.5.10. Duration

Linear scale with the values 0 to 65535 representing the range 0 to 10 seconds. Note that all
65536 values are mapped, but the resolution is only 1ms.

Value Duration/
ms

0-6 0

7-13 1

6554-
6560

1000

65535 9999

11.5.11. Flag

Flags map the DMX value to a boolean value as follows:

Value Meaning

0 False, off

1-255 True, on

11.5.12. HUD Control Bitmask

The HUD control channel is treated as a bitmask except for a few special values:
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Bits Parameter Value

0-3 Layer 0-7 Media layers

8 Text layer

9 Output layer

10+ none

4-5 Position 0 Off

1 Left

2 Centre

3 Right

6-7 Unused

all 255 Grid overlay

11.5.13. Keystone

Linear scale with the values 0 to 65535 representing the range 0 to +1.0. The default value is
0.0 (0) or 1.0 (65535) depending on the corner.

11.5.14. Layer Stretch Mode

Valu
e

Mode Original Aspect
Ratio

Notes

0 Stretch to fill screen Preserved

1 Stretch to fill screen
X

Preserved Other dimension might exceed the target area
and become clipped.

2 Stretch to fill screen
Y

Preserved Ditto

3 Stretch X and Y to
fill screen

Lost

4 Stretch X & Y to
layer 1

- Match aspect ratio & size to layer 1

5 Stretch X & Y to
layer 2

- Match aspect ratio & size to layer 2

6 Stretch X & Y to
layer 3

- Match aspect ratio & size to layer 3

7 Stretch X & Y to
layer 4

- Match aspect ratio & size to layer 4

11.5.15. Mirror / Flip

2026-02-12 ChamSys Manuals 63



Value Effect Notes

0 Normal

1 Horizontal flip

2 Vertical flip

3 H&V flip

4-5 Horizontal mirror Reflected about vertical centre line

6-7 H Mirror & V flip

8,10 Vertical mirror Reflected about the horizontal centre line

9,11 V mirror & H flip

12-15 H & V mirror Horizontal and Vertical mirroring combined

16-255 - Reserved


Mirroring is not available in all places a "Mirror/Flip" channel appears. In
such cases just the first 4 options apply.

11.5.16. Number

The DMX channel value is used as sent, with no decoding.

Note that the media start and end frame parameters use 3 channels. Their range is therefore 0
to 16777215 (224-1). At a typical frame rate of 30 frames a second, the largest value
corresponds to 155 hours, or nearly 6½ days. Although this might seem excessive, it does
mean that points within a media file can be specified with frame accuracy regardless of
length or speed.

Values greater than the number of frames in the clip are taken to mean ``the end''. i.e. a 200
frame clip will restart at 200 frames, rather than 6½ days later, if the end frame is left at the
default of 16777215.

11.5.17. Physical Effect

Physical effect is usually accompanied by up to 3 additional parameters called FX-1, FX-2 and
FX-3.

Value Effect Notes

0 None

1 Shake Gentle FX-1 Horizontal
amplitude

Range ±0.1 of screen width

FX-2 Vertical amplitude Range ±0.1 of screen height

FX-3 Rotation amplitude Range ±5°
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Value Effect Notes

2 Shake FX-1 Horizontal
amplitude

Range ±1 screen width

FX-2 Vertical amplitude Range ±1 screen height

FX-3 Rotation amplitude Range ±180°

3 Scroll FX-1 Horizontal ,scroll speed

FX-2 Vertical ,scroll speed

4 Scroll to
Index

FX-1 Horizontal index Range 0 to 255/256 of screen width

FX-2 Vertical index Range 0 to 255/256 of screen height

5 Tile FX-1 Horizontal tiles Range 1 to 255

FX-2 Vertical tiles Range 1 to 255

FX-3 Mirroring 0-63 None

64-127 Horizontal mirror odd
tiles

128-191 Vertical mirror odd tiles

192-255 H+V mirror odd tiles


Changing between Scroll and Scroll to Index does not reset the position, so
they can be combined to give static and moving scrolls.

11.5.18. Play Mode

Val
ue

Action Notes

0 Once Play clip once, hold last frame

(hold first frame if playing backwards).

1 Once-
then-
black

Play clip once, then go to black

2 Loop Loop in the current direction of play

3 Bounce Reverse direction at first/last frame.

4 First
frame

Show start frame(1).

5 Last
frame

Show the end frame(1).

6 Pause Show the current frame, regardless of speed.

7 Next
frame

Advance to the next frame then
automatically pause(2).
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Val
ue

Action Notes

8 Once Rsrt
Int 0

Same as Once, but media restarts when
intensity is increase above 0.

9 OnceB
Rsrt Int0

Same as Once-then-black, but media restarts
when intensity is increased above 0.

10 Loop Rsrt
Int 0

Same as Loop, but media restarts when
intensity is increased above 0.

11 Bnce Rsrt
Int 0

Same as Bounce, but media restarts when
intensity is increased above 0.

(1) Note that these modes ignore playback speed and always show the selected frame. If the
start or end frames are changed, the displayed frame will change. This allows the user to view
the start and end points as they are moved around within a clip.

(2) Play mode must go back to Pause before this mode can be used again.

11.5.19. Scale

Pseudo-logarithmic scale factor with the values 0 to 65535 corresponding to a multiplication
factor of 0.0 to 10.0, with 32768 being 1.0.

11.5.20. Screen Offset

Linear scale, with the values 0 to 65535 corresponding to an offset in screen position of -1.0 to
+1.0. 32768 corresponds to 0, i.e. no offset. A value of 0 in the X position of a layer, for
example, would move the layer one screen width to the left (-1), effectively taking it just out of
view (if its width was unchanged).

11.5.21. Scroll Position

Linear scale, with the values 0 to 65535 corresponding to a scroll position of -100.0 to + 555.0.
When scrolling in X the position is in characters. When scrolling in Y the position is in lines.
(0,0) is the top left of the first character in a piece of text.

11.5.22. Scroll Speed

When used to scroll the content of a layer, the speed is in units of width or height. In other
words, a speed of 1.0 will scroll the entire width (or height) in 1 second.

Value Speed Notes

0 0 Reset to start position

1-127 1.0 - 0.008 Negative (Left, Down)

128 0 Stop

129-255 0.008 - 1.0 Positive (Right, Up)
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11.5.23. Speed Factor

Speed is represented as a multiplier to be applied to the normal speed, with the values 0-
65535 encoded linearly as follows:

Value Speed Multiplier Notes

0 -500% Backwards at 5 times normal
speed

26214 -100% Backwards

32768 0 Stop

39321 100% Forwards at normal speed

65535 +500% Forwards at 5 times normal speed

11.5.24. Text Loop Mode

Value Action Text Behaviour

0 Loop Scrolling loops round

1 Stop Scroll then stop

2 Bounce Scrolling reverses direction

11.5.25. Transition Type

Not implemented yet.
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Changes to DMX Personalities

Changes in Version 1.8.8.0
The MagicHD Layer personality has had the play mode functionality updated to include four
new modes that will restart the media clip if the intensity is reduced to and increased from 0.

,Play mode

Value Action Notes

8 Once Rsrt Int 0 New mode

9 OnceB Rsrt Int0 New mode

10 Loop Rsrt Int 0 New mode

11 Bnce Rsrt Int 0 New mode

Changes in Version 1.8.7.2
The MagicHD Quick mode personality has been added to the library.

There should now be two media server personality files: "media server_MagicHD.hed" and
"media server_MagicHD_Quick.hed".

The existing individual head files for Master, Layer and Text are the same and no changes
have been made to these.

Changes in Version 1.6.6.1
Text Layer

Chann
el

1.6.6.0 1.6.6.1 Notes

26 Pause 1 Scroll
char

Pause 1 removed.

Scroll char was Not implemented yet, now implemented.

28 Pause 2 Scroll
line

Pause 2 removed.

Scroll line was Not implemented yet, now implemented.

30 Scroll
char

Scroll
time

Scroll char moved.

Scroll time was Not implemented yet, now implemented.

32 Scroll
line

Border Scroll line moved.

Border is a new parameter
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Chann
el

1.6.6.0 1.6.6.1 Notes

34 Scroll
time

- Scroll time moved.

Changes in Version 1.6.1.4
Colour Effect

Value 1.6.1.3 1.6.1.4 Notes

3 Colourise Posterise Was marked as Not implemented yet.

4 Colourise B&W Colourise Name change only

5 Curve 1 Mask New effect

6 Curve 2 Key New effect

7 Curve 3 Hue New effect

8 - Curve 1 Not implemented yet.

9 - Curve 2 Not implemented yet.

10 - Curve 3 Not implemented yet.

Changes in Version 1.6.1.6
HUD Control

Value 1.6.1.5 1.6.1.6 Notes

255 - Grid New feature

Keystone

Value 1.6.1.5 1.6.1.6 Notes

all -1.0 to +1.0 0.0 to +1.0 Range and defaults changed.

Output Layer

Channel 1.6.1.5 1.6.1.6 Notes

24 Keystone X Keystone A Name and effect changed.

26 Keystone Y Keystone B Was marked as Not implemented yet.

28 Keystone A Keystone C Was marked as Not implemented yet.

30 Keystone B Keystone D Was marked as Not implemented yet.

32 Keystone C Keystone E Was marked as Not implemented yet.

34 Keystone D Keystone F Was marked as Not implemented yet.
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Channel 1.6.1.5 1.6.1.6 Notes

36 Keystone E Keystone X Was marked as Not implemented yet.

38 Keystone F Keystone Y Was marked as Not implemented yet.

Changes in Version 1.6.5.0
Output Layer

Channel 1.6.1.6 1.6.5.0 Notes

41 - Audio Volume New

Media Layer

Channel 1.6.1.6 1.6.5.0 Notes

41 - Audio Gain New

42 - Audio Pan New

Changes in Version 1.6.5.1
Colour Effect

Value 1.6.5.0 1.6.5.1 Notes

5 Mask Mask Added fixed colour mode as option 4.

7 Hue Hue Offset Name change only

8 Curve 1 Hue Filter New effect

9 Curve 2 Invert New effect

10 Curve 3 Curve 1 Not implemented yet.

11 - Curve 2 Not implemented yet.

12 - Curve 3 Not implemented yet.

Changes in Version 1.6.6.6
Media Layer

Channel 1.6.6.5 1.6.6.6 Notes

43 - Physical effect New effect

44 - Fx parameter 1 New

45 - Fx parameter 2 New

46 - Fx parameter 3 New
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Changes in Version 1.6.6.8
Media Layer

Channel 1.6.6.6 1.6.6.8 Notes

12 Mirror/Flip Mirror/Flip Details changed

43 Physical effect Physical effect Added scroll to index and tile

Output Layer

Channel 1.6.6.6 1.6.6.8 Notes

41 - Physical effect New effect

42 - Fx parameter 1 New

43 - Fx parameter 2 New

44 - Fx parameter 3 New

Changes in Version 1.6.6.9
Colour Effect

Value 1.6.6.8 1.6.6.9 Notes

5 Mask Mask Added Transparent and Inverse Transparent modes.
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Folder Structure

../MagicQ PC
     +- mqqt.exe             MagicQ PC executable
     +- mqhd.exe             MagicHD standalone executable
     +- convert              incoming user media files for conversion.
     |   +- 010
     |   :
     |   `- 255
     +- log
     |   +- mqhd_xxxxx.log   MagicHD log files
     |   `- conversion       media conversion log files
     +- show
     |   +- index.csv        media index
     |   `- media            media
     |       +- 001
     |       :
     |       `- 255
     `- thumbs
         `- local            thumbnails of the media in show/media
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